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Time Activity

1:30 Intros and Info

2:00 ArcGIS Online

2:45 Break/Discussion

3:00 Field Maps

3:45 Break/Discussion

4:00 ArcGIS Desktop

4:30 Outro

During the breaks, we will be mostly off, but people that want to stay on to ask questions 
can feel free to do so
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You’ll notice that no where on here does it say “expert in geographic systems analysis”. 
Introduced to GIS during my PGC in college
Figured things out through trying new things

When I originally designed this workshop, it was for masters/phd students with access to 
ArcGIS that might otherwise just be collecting paper and pencil data. This has been 
modified slightly for this conference, but still is very much just an introduction to these 
systems and how to set them up. If you already have an organizational lead doing these 
things, you might not be able to take too much away from this workshop. If you decide this 
isn’t helpful, I will in no way be offended if you wave bye and leave!
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Avian Analog

Affiliation

Data Interest/Type
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Good Things Not-So-Good Things

Validate your data entry in field! 
Standardize your protocols amongst observers!
Put the right thing in the right place!
Force entry of  required fields.

Time consuming to set up and maintain. 
Changes to protocols can be tricky to introduce 
once data is already collected. 

Reduce data entry in office. Save trees!
CAN collect without internet connection.

Means you aren’t double checking data by default

Link in-field photos to data points Difficult to take out of  the online platform. 
Downloading online layers doesn’t include photos. 
Easy to overwrite if  not careful. 

Can set accuracy limits (default +/- 10m). In my 
experience, accuracy is about +/- 3m.

Some GPS discrepancies between devices, but can 
be pretty accurate compared to GPS units. 

Create auto-updated visual depictions (dashboards)
Share your data throughout your organization.

This stuff  is just awesome. 

Maybe you don’t want to work in the rain or for 
long hours. 

Rain significantly impedes one’s ability to collect 
data. Need to carry extra battery for device.

ALL of our data are spatial in nature. This type of data collection is truly the future of our 
field. The opportunities are nearly endless.
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*Lengthy, complex steps
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Welcome!
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univMB is the organization url. You can also sign in with your ArcGIS Login, which has your 
UofM login with “_UnivMB” after, and a password you need to set up.
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Full email and password. Make sure Meg Miller has set up your account. 
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Welcome screen has all the good stuff. Let’s try clicking each of the banners. We’ll go 
through the collaborative stuff and then into the data set-up side of things. 
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Has Library datasets. Lots of cool layers in here.
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Can see all the other UofM members, can access TRAINING and lessons
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Can create groups where you have clusters of shared data. Great for collaborative projects. 
Could even have a group where we have all the Koper Lab data so Nicky can look at your 
stuff as you collect it! But there are also existing groups “Featured Groups” and “My 
Organization’s Groups”

Not going to spend any more time on the collaborative side of things, but did want to point 
out that it’s an option, and Nicky particularly might want to explore it. 
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Has a general folder structure, can have multiple different file types.

Feature Layers
Web Maps
Dashboards
.shp/.gdb files
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Click create new item to add or create data layers
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Can create layers from scratch, or you can upload existing CSVs, SHPs, GDBs, etc. 

Establish a naming convention early! Especially if you’re using multiple layers to collect data 
you hope to compare. 
Ex. If you start using ‘site’ to describe a sampling location, stick with that across all your 
layers. Generally use ‘_’ as opposed to periods or spaces. 
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LOTS of options to use existing templates, layers, or start from scratch. You CAN make 
multiple vector layers (ex. Points, lines, and polygons) all within a single Feature Layer. This 
groups them together, so whenever you open the feature layer it loads all the layers within 
it. Later, we’ll go through how to start from an excel template
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After you make a new layer, it’ll take you to the layer’s overview. Here, I just replicated an 
existing layer I had created for collecting Range Health Assessment data. It has a ton of 
fields, each with some existing data validation lists. This step is critical for making sure you 
are collecting data as you need it. Pay close attention to the character limits of field names, 
the display names and the field type! Know the difference between when you need to 
collect dates, integers, double (decimals), and strings (text). This makes your life easy later. 
The first thing we’re going to do is go to Settings. 

24Sep. 13, 2022

Zachary M. Moore - SCO-SOC Field Maps 
Workshop



ALWAYS TICK THIS BOX SO YOU DON’T DELETE YOUR DATA. But there are also other settings 
like approving public data collection. 
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Scroll down to these other critical settings. Specifically the “Enable Sync”. This feature is 
what allows you to collect and upload data in Field Maps. Without this ticked, Field Maps 
will get upset with you when you go to set it up. You can also choose what kind of editing 
you want your users to be allowed to do, and if you want to create fields that track who 
created and edited features and when. 

26Sep. 13, 2022

Zachary M. Moore - SCO-SOC Field Maps 
Workshop



Scroll back up and hit data, then go to fields so we can edit them. If you click on any given 
field you’ll see the properties for it. 
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Here, you can edit a bunch of stuff to do with the field and see what type it is. This one 
already has a List of Values (Domain) that populate a drop down menu in field maps. 
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If you click edit, you can change the list of values. Here, “Label” is what will appear in the 
drop downs, and “Code” is what each entry will store in the actual data tables. 

NOTE: editing the list here does not update your data. You will need to edit your data to 
match the list specified here. 

This is why it is important to get what you want right the first time, when you are setting 
up, in order to save yourself hassle later. Good validation lists make for good entry and 
analysis. You CAN set these up manually, but you have to enter them individually and it’s 
quite complicated to copy lists across multiple fields. If you have large or complex or 
repeated lists (like species lists or percent cover for example), it’s better to set up your data 
in ArcGIS Pro and use the “Table to Domain” geoprocessing tool, and then upload this to 
ArcGIS Online so you can use it in Field Maps (see later in presentation). Editing domains in 
the desktop app is much simpler, but once the layer is created in Online, you CANNOT edit 
domains for Online layers EVEN if you open the layer in ArcGIS Pro Desktop. 

29Sep. 13, 2022

Zachary M. Moore - SCO-SOC Field Maps 
Workshop



You can also set up your data structure using a .CSV file excel where each of your fields is a 
column, and underneath each column is all of the options you want for the drop down list. 
Make sure you have empty location columns so that ArcGIS Online can recognize you want 
to attribute locations to new observations later. 
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You can also set up your data structure using a .CSV file excel where each of your fields is a 
column, and underneath each column is all of the options you want for the drop down list. 
Make sure you have empty location columns so that ArcGIS Online can recognize you want 
to attribute locations to new observations later. 
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Upload the file 

Then, in Contents>Data>Fields>Create List, you can tap ‘Generate List’ in the bottom corner 
to create the drop down, then you can delete the data in the table. However, you can only 
do this for lists of <1000 observations.
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Add as a feature layer and a .csv
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Check that each field is the correct type or you’ll run into issues later!
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Agree to set up by lat long in your x/y columns. 
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Add layer information.
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You’ll end up in the info for the feature layer, go to Data> Fields and select each of the fields 
you wrote a list for. 
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Select create list
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Select generate list in the bottom corner, and the list will autopopulate with every option 
from that column. Now, your drop downs will have these values in Field Maps. Save, and 
exit. Do this with EACH field you set values for. 
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Then, go back to New Item in content, 
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Then, go back to New Item in content, select your template with the domains defined, and 
create a new copy of this template to remove all of the points in the old one. 
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NOW your layer will have all the domains you set from your excel template!
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If we get out of there and go to visualization, we can change how this layer will look every 
time we open it. We can add labels, change symbology, even filter or configure pop-ups. 
The pop-ups are an underappreciated nuance of this work, as this is the default that Field 
Maps will use to start the form. 
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You can change the visualization so it populates with the list of values you added to a field, 
and this will make it so that when you go to create the field maps, it gives you these 
options to start your forms. Don’t forget to click save! Once you’re done here, go to Map in 
the top banner. 
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You can add layers to the map here, then save it to your folder. I recommend that you use 
the “Map Viewer” (top right) as opposed to Map Viewer Classic, because it allows you to 
group Feature Layers with multiple Layers into collapsible units. In general, the new “Map 
Viewer” has more features but Online still offers the more familiar version of the past. 

You can add layers that you have made, but you can also search the vast ArcGIS online 
portal for any publicly available layer. There is A LOT of background data you can add to 
your map from here without having to set up anything yourself. 

45Sep. 13, 2022

Zachary M. Moore - SCO-SOC Field Maps 
Workshop



Navigate to the layer you want and add it to the map
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And it will open with your saved visualization changes. 
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Save the map so we can open it in Field Maps. However you set up the map will be how it 
appears in Field Maps (ie. Whether layers are turned on or off, how they are 
labelled/visualized, etc.)
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*You COULD get advanced here. If you have an existing online layer that you want to edit or 
add some complex domains (drop-down lists), you could copy the layer to a desktop 
geodatabase, edit the domains, and then overwrite the online layer, BUT you would LOSE 
ANY PHOTOS in the original online layer. 
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Navigate to the map in the portal section of contents and Add and Open
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Then you will have access to your map!
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In Catalog, navigate to the local folder you want to create the database, right click > new > 
file geodatabase. You can probably also create this geodatabase in the portal contents, but 
I’ve found it more reliable to set up everything in desktop and then upload to the portal. 
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In contents, right click gdb > new > feature CLASS. Name and select point, line, or polygon. 
Click NEXT
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Add fields and types wanted! Double = decimal values. Date is very valuable for anything 
where you want to collect a date and a time. Check field properties! Change as necessary 
to specifiy an alternative Name, a default value, or if NULL values are allowed. Here, the 
Alias will be the display name, so you’ll want to do these carefully. You can also IMPORT 
from a table if you set up the right file type. Click NEXT
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Select your coordinate system. You can use the map default, or you can pick another layer 
to match. You can click FINISH after this, as the next fields are likely less important!
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Your new layer will be added to the current map. Right click the layer in CONTENTS > Data 
Design > Domains
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DO NOT FORGET 
TO SAVE YOUR 

CHANGES

When in domains, you can manually create lists and then assign them to fields within your 
.shp files. This is done for given field types (text, integer, double). Code is the stored value, 
and Description is the value that will be visible in the drop downs. 
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Right click the layer > Data Design > Fields to assign your newly created domains to a field 
in the domain section
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Right click the layer > Data Design > Fields to assign your newly created domains to a field 
in the domain section. Now, when you use the file in field maps, it will autopopulate the 
drop downs with your values!
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You can add a domain for a complicated or long list!
Open the list as a table in your map. 
Open the “Table to Domain” Tool
Specify the input table as your list, which column to use for Code and which for Description
Choose your Geodatabase as the Input Workspace
Enter your domain name and description
Run Function. 
It’s now a domain, and you should be able to select it as a domain in the fields page. 
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Now, it’s a domain, and when you go to enter data in the field, your drop list will be 
populated with all the species in Alberta! You can then search for the right species as you 
start writing!
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Right click your layer in contents > sharing > share or overwrite web layer. Easy! Now you 
can use it in the webmaps and then format for field maps.
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Zip your GDB into a compressed folder, and then you can drag and drop it into the New 
Item upload in ArcGIS online

67Sep. 13, 2022

Zachary M. Moore - SCO-SOC Field Maps 
Workshop



Make sure you set the item type to file geodatabase, and click add the zip and the hosted 
feature layer. The next screen will let you choose where to upload and add information
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Now, your newly created SET of .shps will be in a single feature class. I’ve only added one 
here as an example, but you can put however many you want!
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Here, if you go into the TEST_POLY layer and the TEST_TEXT field, you can see that I set the 
domain to be all of the species in AB! When you load this layer into a webmap, and then 
open that webmap in Field Maps, you will be able to select from the domains you’ve 
created!
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You can get to field maps from the Home tab. 
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Now, your new map will be available to edit. 
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The first thing we’ll do is check the offline settings.
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The Offline toggle allows one to download or ‘check-out’ portions of the map in the mobile 
app for offline use, collect data without an internet connection, and then ‘sync’ the data 
later. If the Offline toggle is off, there will be an issue with one of the layers. You should be 
able to automatically select an option to fix this. 
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With offline settled, we can start to configure our forms. The easiest way is just to convert 
the pop-up, which you may or may not have edited in the “Visualization” section of the 
layer in question. 
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There are lots of options once you have a form started. It is important to note as well that 
the names here will default to the “Display Names” when you create the layer, so if you 
edit them there, they will pop up how you want to view them whenever you load the layer 
in Field Maps (and you won’t have to change them every time). My personal preference is 
to set up Groups, which allow you to collapse sets of fields into areas. You can drag the as 
many groups out as you want, and then drag fields into it. 
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With groups, you can toggle if you want the group to be expanded or collapsed when you 
first open the layer for entry in the app, and you can create dependencies for the values of 
a field using the Conditional Visibility. You can also add descriptions and change the name 
of the group. 
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When you click on any individual field, you can change a lot of things. You can change the 
display name, add a description of the field, change the input type (depending on the field 
type), make it ‘required’ to submit the point, add a placeholder or default value, and add 
conditional visibility dependent on other fields or conditions. You can also set fields to 
autocalculate, which can be very helpful when you want to sum scores for different 
surveys. I know that reviewing lots of Range Health Assessments and other reports, people 
make mathematical errors in assessments, but this can help to solve that. 
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DO NOT 
FORGET TO 
SAVE

Don’t forget to save your changes REGULARLY. Sometimes the platform can glitch and erase 
your progress if you do too many edits without saving. It is also better to NOT have the 
Field Maps editor and the actual map open in ArcGIS Online at the same time because they 
can glitch and overwrite progress. 

With some work, you can get to a very good looking, efficient form that will greatly 
increase the efficiency of your entry in field. 
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In this previously completed form, you can see that I have been able to organize over 75 
fields into groups and have created conditional visibilities that show groups only in 
situations where they are necessary. This will be how the form opens in the app, with all 
the drop downs you’ve populated. 
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So that was the Online Portion. Where we go from here is loading the information on field 
maps so you can actually collect the data!
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